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News In Preview

The first article describes how to import Micro-Cap 6 schematic and plot graphics into other programs.
In particular, it shows how to import graphics into Microsoft Word and Excel. As these are
representative programs, the article should be useful for other programs as well.

The second article describes the new Duncan Munro-designed vacuum tube models and demonstra-
tion circuits. These components let you simulate various tube-based circuits, so it should be useful for
those experiencing technological nostalgia, as well as those of you who are designing tube circuits for
guitar amps and other socially useful applications.

The final article demonstrates how to measure phase margin, a topic which has come up several times
recently in the tech support emails.
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Book Recommendations

Micro-Cap / SPICE
• Computer-Aided Circuit Analysis Using SPICE, Walter Banzhaf, Prentice Hall 1989.
 ISBN# 0-13-162579-9
• Macromodeling with SPICE, Connelly and Choi, Prentice Hall 1992.
 ISBN# 0-13-544941-3
• Semiconductor Device Modeling with SPICE, Paolo Antognetti and Giuseppe Massobrio
  McGraw-Hill, Second Edition, 1993. ISBN# 0-07-002107-4
• Inside SPICE-Overcoming the Obstacles of Circuit Simulation, Ron Kielkowski,
  McGraw-Hill, First Edition, 1993. ISBN# 0-07-911525-X
• The SPICE Book, Andrei Vladimirescu, John Wiley & Sons, Inc., First Edition, 1994.
 ISBN# 0-471-60926-9
• SMPS Simulation with SPICE 3, Steven M. Sandler, McGraw Hill, First Edition, 1997.
 ISBN# 0-07-913227-8
• MOSFET Modeling with SPICE Principles and Practice, Daniel Foty, Prentice Hall, First Edition,
 1997. ISBN# 0-13-227935-5

German
• Schaltungen erfolgreich simulieren mit Micro-Cap V, Walter Gunther, Franzis', First Edition, 1997. ISBN#
3-7723-4662-6

Design
• High Performance Audio Power Amplifiers, Ben Duncan, Newnes, First Edition,
 1996. ISBN# 0-7506-2629-1

High Power Electonics
• Power Electronics, Mohan, Undeland, Robbins, Second Edition,
 1995. ISBN# 0-471-58408-8
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Micro-Cap 6 Questions and Answers

Question: When I run my circuit it says it can't find a particular subckt part. What did I do wrong?

Answer: Micro-Cap 6 expects to find all subckt and model statements in the default data directory
or in the location specified by the environmental variable MC6DATA. Usually this problem occurs
because you have recently changed the data directory or the MC6DATA variable and MC6 can't
find the library containing the subckt. Remember, when you use the file dialog box to open a file in
a new directory, you change the default directory to the one just opened.

Let's say you have a circuit called A.CIR that uses a small library file called ABC.LIB. Let's assume
that both are happily living in a directory called c:\mc6\project2 and that you routinely work from
this location. Now you start a new project and you create a new folder at c:\mc6\project3 and
copy the circuit file A.CIR into the folder to use a starting point for the new project. You change
the A.CIR a little and try to run a transient analysis. You get the message "No such file or directory
c:\mc6\project3\ABC.LIB". That's because the current data path is c:\mc6\project3 and there is
no ABC.LIB file there.

There are two general solutions to this problem:

1) Keep both model library files and circuit files in the same location.

2) Keep the libraries in a path specified by the environmental variable MC6DATA. Then you can
use one or more circuit directories to work out of. To modify the MC6DATA value in W98, you
must add this line to your autoexec.bat file on the boot drive (usually the C drive).

SET MC6DATA=C:\MC6\MYLIBS

where C:\MC6\MYLIBS is the path to your model directory.

NT has its own way of setting the environmental variables.  Go to the Control Panels and double
click on System.  Go to the Environment tab.  There are two text fields: Variable and Value.
Variable would be MC6DATA and Value would be the path to the desired directory.  After typing
these in click on the Set command button, then click the OK button.  It should work after this.

Question: There are two ways to draw an orthogonal wire between two points. How do I change
the way the program has chosen to draw the wires as I'm drawing them?

Answer: Click the right mouse button while dragging the wire. This will toggle the two-branch
wire between the two possible routes.

Question: What is Gear integration and when should I use it?

Answer: Infrequently and with caution. There are two type of integration methods available, Gear
and trapezoidal. Trapezoidal is the default method and is the best choice for most circuits. How-
ever, for power circuits where inductors are being switched by diodes or other devices, Gear is
sometimes the best choice. It is a lossy integration method which attenuates high frequency
oscillations that, while technically correct, are of no interest to the user and tend to slow down the
simulation. The one area where you should definitely avoid Gear is in LC oscillators. A pure LC
tank circuit with an initial voltage on the cap will oscillate forever with trapezoidal integration, but
will rapidly decay with Gear integration.
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Easily Overlooked Features

This section is designed to highlight one or two features per issue that may be overlooked because
they are not made visually obvious with an icon or a menu item.

Control+Drag
There is probably no easier way of creating new circuit parts than the use of the control-drag copy-
ing method. It is such a simple and elegant method that once you use it, you'll never use the old
methods again.

It works this way: Press the CTRL key and drag on an object. Drag and drop the resulting copy.
For instance, press the CTRL key and drag on a diode. A copy of the diode is made and attached
to the mouse. Drag it to where its needed and drop into position. No need to select the part from a
menu. No need to specify its parameters. Just drag and drop.

If the part is a resistor and you need to change its value, then, after dropping the part, double click
on it and enter the new value. It's easier than selecting it from a menu.

You can do the same with text. Drag a piece of text. Double click on it and edit. This is especially
useful if the new text is similar to the old and requires minimal editing.

Note that MC6 will increment text to avoid generating duplicate node names. It will only do this
for text that is a possible node name (doesn't contain spaces or other illegal characters). So large
blocks of text with spaces never get incremented.

You can also drag and drop entire sections of a circuit. It works the same way.
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Importing Micro-Cap Schematics and Plots Into Other Documents

Microsoft Word Documents
Ever want to include a schematic or a plot picture file in a report you're writing? Here is how to do it.
There are two basic steps:

1) Create the picture file. To do this, open the Edit menu and select the Copy Entire Window to a
Picture File option. This will bring up a file dialog box where you can specify the name and location
of the file to save the picture to. This option saves under the Windows Meta File (WMF) format. This
is a very flexible format that lets you resize the image within the target document.

2) Run Word and load the document to receive the picture file. Make sure the text cursor is at the start
of a new line. Select the Picture item from the Insert menu. Select the From File option. A file dialog
box will be presented. Specify the Micro-Cap data directory as the file location. Pick the picture file
you want, using the same name as in step 1. The picture file will load. It can be re-sized and moved
around with tabs and spaces to achieve the layout you need. Here is a sample Word page showing two
picture files, a schematic and a transient analysis plot.

Fig. 1 - Importing into a Word document
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Fig. 2 - Importing into an Excel document

Microsoft Excel Documents
The procedure for importing into Excel is nearly the same. First create the document in the same way.
Then import it by using the Select the Picture item from the Insert menu, Finally,  select the From
File option. Here is what a typical Excel document with imported Micro-Cap pictures might look like:

You can also use the clipboard as a transfer mechanism. The Copy to Clipboard option on the Edit
menu gives you several methods:

Copy the Visible Portion of the Window in BMP Format: This copies just the visible portion of
the window to the clipboard in BMP format. Parts that are scrolled off-screen will not be included

Copy the Select Box Part in BMP Format: This copies just the portion of
the window within the select box to the clipboard in BMP format. Parts outside the select box
are ignored.

Copy the Entire Window in EMF Format: This copies the entire window in EMF format.

Copy the Entire Window in WMF Format: This copies the entire window in WMF format.
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New Duncan Munro Vacuum Tube Models

New vacuum tube models created by Duncan Munro have recently been ported to the Micro-Cap 6
parts library. There are nineteen triodes and eight pentodes. Some have heaters and some don't. The
breakdown looks like this:

Triodes No Heater Triodes With Heater
2A3 12AU7 6SN7GTB_H
3CX300 12AX7 12AT7_H
SV6AS7 76 12AU7_H
6BM8 300B 12AX7_H
6DJ8 SV5723
6N1P SV57210
6SN7GTB 5751
12AT7

Pentodes No Heater
6BQ5 6V6
6CA7 SV83
6KG6 6146
6L6 EF86

The models and several demonstration circuits have been ported to MC6 and will soon be a part of the
MC6 package.

As an example consider the circuit of Figure 3. It was used to sweep the plate voltage to generate
the plate characteristics of the 12AX7 tube. Figure 4 is a plot of the static plate characteristics of
the 12AX7 tube. Figure 5 shows the actual plate characteristics from an old GE tube book (circa
1958). The match is very close and a tribute to Duncan's modeling work.

Figure 6 shows the tube configured as a linear amplifier. The transient response to a sinusoidal
excitation is shown in Figure 7. Figure 8 shows the AC gain characteristics of the same circuit.
Note that the gain at 1KHz matches the gain as measured in transient analysis.

Fig. 3-The 12AX7 plate characteristics test circuit.
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Fig. 4 -Simulated plate characteristics of the 12AX7 tube model.

Fig. 5 -Actual plate characteristics of the 12AX7 tube.
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Fig. 6-The 12AX7 in a linear amplifier circuit.

Fig. 7 -Transient analysis voltage waveform of the plate with a 2mV 1Khz input

Here is the output waveform with a 2mV 1kHz sinusoidal input waveform. The peak to peak
voltage is measured at 112.18 mV yielding a gain of dB(112.18mv/2mv) =34.97 dB.
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Fig. 9 -An AC\DC Amplifier

Here is the AC analysis showing a plot of the voltage in dB (for a 1v AC input) measured at the
plate. Notice that it matches the 34.97 dB measured in the transient run.

If you have an interest in the circuits, models, or other esoterica of vacuum tubes, you should see
Duncan's site at www.duncanamps.simplenet.com. It's a tube-lovers's paradise.

As a further example of tube schematics and simulation consider the circuit of Fig 9. It is a sche-
matic of an amplifier from the same GE tube handbook.

Fig. 8 -Bode plot of AC voltage gain at the plate
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Fig. 10 -The Micro-Cap 6 schematic of the amplifier

Here is the schematic rendered in MC6 using the 6L6 as a substitute for the 35C5 pentode.

Here is the transient analysis showing the input 20mV P-P, 1KHz signal and the resulting output
voltage across the simulated speaker load.

Fig. 11 -Transient analysis plot of voltage waveform across Rload
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Here is the AC analysis showing the dB value of the output voltage across the speaker load,
RLOAD. Notice that it shows about 41 dB, the same amount measured from the transient analysis
waveform.

Fig. 12 -Bode plot of AC voltage gain at Rload

The Duncan models should provide a consistent and useful basis for analyzing these old curmudg-
eons of technology. The basic 3/2 power models has been elaborated to include the change in
anode resistance and the reduction in µ at large negative grid voltages. It also models the anode
current limiting that occurs with high positive grid and low positive anode voltages.
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Measuring Phase Margin

Ever wanted to measure phase margin? It's simple. We'll demonstrate with this sample circuit:

Here is the AC analysis, showing the gain in dB, the phase in degrees, and the phase margin in de-
grees. Phase margin is the difference in the phase value and -180 degrees, or mathematically it is:

Phase Margin = PH(V(OUT)) - (-180) = PH(V(OUT)) + 180

Fig. 13 -Amplifier to be analyzed

Fig. 14 -Bode plot of  gain, phase, and phase margin
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To measure the phase margin conveniently do the following:

1) Run AC analysis

2) Select the Go To Y item from the Scope menu. When the Go To Y dialog box comes up,
specify a Y value of 0. Click on the Left button. Click on the close button. This positions the left
cursor on the dB(V(OUT)) waveform where its value is 0. Since the Align Cursors option is en-
abled, it will also position the left cursors for the phase and phase margin graphs, enabling us to
read the phase margin directly from the Left column of the table below the plots. In this case, the
phase margin is read off as 25.25 degrees.

3) After positioning the cursors, you can mark the values by selecting the Tag Left Cursor com-
mand from the Scope menu. This command tags the left cursor of the selected waveform, so you
must select each waveform (click on the waveform name) before using this command.

The figure shows the plots with tags attached, marking and measuring the phase margin.

Why does the upper waveform, V(OUT), have a tag value of -9.63f, when we requested a value of
0.0? Well -9.63f is 9.63e-15 which is very nearly zero. The program interpolates between the cal-
culated data points to position the cursor as close as possible to the requested location. The small
difference is the result of that interpolation.
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Product Sheet

Latest Version numbers
Micro-Cap 6 ....................................................................... Version 1.0.0
Micro-Cap V ...................................................................... Version 2.1.2

Spectrum’s numbers
Sales .................................................................................... (408) 738-4387
Technical Support ............................................................ (408) 738-4389
FAX .................................................................................... (408) 738-4702
Email sales ......................................................................... sales@spectrum-soft.com
Email support .................................................................... support@spectrum-soft.com
Web Site ............................................................................. http://www.spectrum-soft.com

Spectrum's Products
• Micro-Cap 6 (LAN or standalone - 1 license) .......... $3595.00
• Upgrade from MC5 Ver 2 to MC6 .............................. $500.00
• Upgrade from MC5 Ver 1 to MC6 .............................. $750.00
• Upgrade from MC4 to MC6 ......................................... $1100.00

Prices are subject to change. You may order by phone or mail using VISA, MASTERCARD, or
American Express. Purchase orders accepted from recognized companies in the U.S. and Canada.
California residents please add sales tax.
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